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WARNING 
 
 
To ensure the equipment described by this User Manual, as well as the equipment connected to 
and used with it, operates satisfactorily and safely, all applicable local and national codes that 
apply to installing and operating the equipment must be followed. This includes the National 
Electric Code in the USA and other applicable legislation, regulations, and codes in practice 
elsewhere. Since codes can vary geographically and can change with time, it is the user’s 
responsibility to determine which standards and codes apply, and to comply with them. 
 
FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN 
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL. 
 
Persons supervising and performing installation or maintenance must be suitably qualified and 
competent in these duties, and should carefully study this User Manual and any other manuals 
referred to by it prior to installation and/or operation of the equipment. 
 
______________________________________________________________________________ 
 
The contents of the User Manual are believed to be correct at the time of printing; however, no 
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of 
continuous development and improvement, the manufacturer reserves the right to change the 
specification of the product or it’s performance or the contents of the User Manual without notice. 
 
______________________________________________________________________________ 
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________________________________________________________________________________ 
1.1 FEATURES 
 
• Performs high speed control functions of ANC Necker/Flanger. This includes transfer jam 

detection, can jam detection, and Calefi valve control. 
 
• High speed front-end upgrade package which interfaces with existing control system. 
 
• Performs the following control functions: 
 

1) Detection of transfer jams (Stations 1 thru 10 and Flanger). 
2) Detection of can jams (Stations 1 thru 10 and Flanger). 
3) Auto Calibration mode to determine number of stations from infeed screw sensor to transfer 

sensors of each station. 
4) Individually adjusted number of missing cans for transfer jam alarm for each station. 
5) Timing signal fail detection. 
6) Data Acquisition: Total number of good cans necked and flanged, total number of transfer 

jams, number of transfer jams per station. (For both current shift and last shift) 
 
• Built-in 2 Line X 40 character sealed display with 24 key membrane keypad allows local 

viewing of collected data (can count, total jams, transfer jams per station) by operator and set-up 
of all user variables (key switch enabled) by authorized personnel. 

 
• Interfaces directly with machine mounted resolver, infeed screw sensor, transfer sensors (all 

stations) and Calefi solenoids. 
 
• Based on high performance M4500 PLC/PLS module which allows easy trouble-shooting and 

user customization using SYSdev (DOS-based) programming package. 
 
• Built-in PLS provides all machine timing, eliminating need for an additional PLS. 
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________________________________________________________________________________ 
1.2 FUNCTIONAL DESCRIPTION 
 
The HSL-ANCNF Necker/Flanger high speed control package is an electronic upgrade package for 
the ANC necker/flanger which detects transfer jams (all stations), can jams (all stations), and Calefi 
valve control. In addition, the package provides timing signal failure detection and data collection 
including: Total good can count, total number of transfer jams, and transfer jams per station (both 
for the current shift and previous (last) shift). The package interfaces directly to the machine 
mounted resolver, infeed screw sensor, transfer sensors and Calefi solenoids as well as the host PLC 
via discrete DC I/O. 
 
The package is not a dedicated “black box”, but is instead implemented using the high performance 
SYSTEMS M4500 PLC/PLS module. This allows easy customization by either SEA or the end 
user. The M4500 module is programmed using the DOS-based SYSdev programming package. This 
allows the module to be programmed in any combination of Ladder or High-level (subset of “C”), as 
well as perform on-line monitoring and trouble-shooting. The M4500 module incorporates a built-in 
PLS which interfaces directly with the machine mounted resolver and provides all machine timing, 
eliminating the need for an external PLS. 
 
 
________________________________________________________________________________ 
1.3 TRANSFER JAM DETECTION 
 
The transfer jam detection is implemented as follows: Transfer jam detection for each station is 
enabled (a user settable number of shifts) after the infeed screw sensor has detected the first can fed 
into the machine. At this point, if (a user settable) number of missing cans is detected, a transfer jam 
is generated for that station. This is signaled to the host PLC via discrete I/O and the machine 
stopped. This detection is performed for necking stations 1 thru 10 and the flanger. The transfer jam 
detection can individually be disabled for machines not equipped with these stations. 
 
 
________________________________________________________________________________ 
1.4 CAN JAM DETECTION 
 
The can jam detection is implemented as follows: If the transfer sensor for a corresponding station is 
covered for a time delay once the machine is running, a can jam alarm is generated for that station. 
These alarms are available to the host PLC via the transfer jam alarm outputs. 
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________________________________________________________________________________ 
1.5 TIMING SIGNAL FAILURE DETECTION 
 
The timing signal fail occurs when any of the timing signals generated in the PLS section fail to 
change state periodically while the machine is running. This alarm is available to the host PLC via a 
discrete output. This should be used to stop the machine and indicate the problem when the alarm 
occurs. 
 
 
________________________________________________________________________________ 
1.6 DATA COLLECTION 
 
The following data is collected for both the current shift and the previous (last) shift: 
 

1) Total number of good cans necked and flanged 
2) Total number of transfer jams 
3) Total number of transfer jams for each station 

 
This data is viewed (locally) on the Keypad/Display or can be sent to the host PLC via RS-232 
communications (MODBUS protocol) using the optional S4516 communications board. This 
information is updated (“current” shift transferred to “Last” shift) based on the change of state of a 
discrete input. This input can be activated on an 8 or 12 hour shift basis or alternatively could be 
activated manually on a label run basis depending on the user's preference. 
 
In addition to the shift data collection, a separate buffer is available to collect transfer jams per 
station counts as a diagnostics aid to the operator for trouble-shooting a transfer jam problem for a 
specific station. Unlike the shift data, these counts can be reset manually by the operator at will. 
This allows the operator to note an abnormally high count on a specific station, attempt to correct 
the problem, reset the counts and then check the counts at a latter time to determine if the problem is 
corrected. This data can also be viewed on the Keypad/Display display. 
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The standard HSL-ANCNF package is provided for back-panel mounting inside the existing user's 
control cabinet. In addition, a self contained NEMA 12 enclosure can be purchased in for mounting 
adjacent to the existing control cabinet by specifying part number HSL-ANCNF-ENCL. 
 
 
________________________________________________________________________________ 
2.1 WHAT'S INCLUDED 
 
Depending on which package is purchased, verify that the following items are included when 
unpacking the HSL-ANCNF: 
 
 
________________________________________________________________________________ 
2.1.1 HSL-ANCNF (for back-panel mounting) 
 

1ea. HSL-ANCNF back-panel for mounting in the existing user's control cabinet including 
the following: 
1ea. M4500 PLC/PLS module 
1ea. P4500 Power Supply 

 
1ea. D4591 Display with ribbon cable for mounting in the existing user's control cabinet 

door. 
1ea. HSL-ANCNF User's Manual 
1ea. M4500 User's Manual 
1ea. HSL-ANCNF Program Disk 

 
 
________________________________________________________________________________ 
2.1.2 HSL-ANCNF-ENCL with NEMA 12 ENCLOSURE) 
 

1ea. HSL-ANCNF NEMA 12 enclosure including the following: 
1ea.M4500 PLC/PLS module 
1ea.P4500 Power Supply 
1ea.D4591 Display/Keypad 

 
1ea. HSL-ANCNF User's Manual 
1ea. M4500 User's Manual 
1ea. HSL-ANCNF Program Disk 
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________________________________________________________________________________ 
2.1.3 HSL-ANCNF OPTIONS (PURCHASED SEPARATELY) 
 
The following items can be purchased separately as required or desired. All items are compatible 
with both the back-panel mountable package or the NEMA 12 enclosed package: 
 

1ea. S4516 Data Communications Board (MODBUS and DF1 protocols) 
1ea. RSV34-MS1 Resolver 
1ea. RSV-RSCBLE-XX Resolver Cable 

 
 
________________________________________________________________________________ 
2.2 HSL-ANCNF INSTALLATION 
 
 
________________________________________________________________________________ 
2.2.1 POWER REQUIRED 
 
The HSL-ANCNF is powered from 115VAC/230VAC 50/60HZ and +24VDC. The 
115VAC/230VAC is used to power the M4500 module while the +24VDC is used to power the 
+24VDC I/O (sensors, transfer jam outputs and Calefi valves). The +24VDC current required by the 
HSL-ANCNF is no more than the existing system's +24VDC current requirement, therefore the 
existing +24VDC power supply should be adequate. 
 
 
________________________________________________________________________________ 
2.2.2 MOUNTING AND WIRING THE HSL-ANCNF 
 
If installing the HSL-ANCNF package mounted in the NEMA 12 enclosure, mount the HSL-
ANCNF NEMA 12 enclosure in proximity to the existing control cabinet. 
 
If installing the HSL-ANCNF back-panel mounted package, mount the back-panel in the existing 
control cabinet. Referring to the M4500 User's manual, cut a cut-out in the existing control cabinet 
door and mount the D4591 display.  
 
Note: The D4591 must be located within 6 feet of the M4500 module to avoid EMI pick-up on the 
Display ribbon cable. Connect the ribbon cable from the M4500 module to the D4591 module. 
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Wire the HSL-ANCNF to the existing control system, referring to the electrical control schematic at 
the back of this manual, keeping all +24VDC wiring away from high voltage wiring. Wire the 
machine mounted resolver directly to the 8-pin resolver input connector on the M4500 module using 
a three pair, two conductor shielded cable. The shield of the resolver cable should be tied to the 
M4500 resolver input connector as shown on the electrical schematic. Make sure the resolver cable 
shield is left floating at the resolver. Refer to the electrical control schematic at the back of this 
manual for details. 
 
 
________________________________________________________________________________ 
2.2.3 MOUNTING THE RSV34-MS1 RESOLVER 
 
The HSL-ANCNF is designed to interface to a resolver (not encoder) for machine timing. If the 
machine is not already equipped with a resolver, then the existing encoder will have to be removed 
and a resolver (RSV34-MS1) will have to be mounted in it's place. If this is the case, refer to the 
RSV34-MS1 resolver data sheet for details on mounting the resolver.  
 
Note: The resolver must make one revolution for each can. Use the RSV-RSCBLE cable to connect 
the resolver to the HSL-ANCNF. Route the resolver cable in a separate conduit, away from all other 
high voltage and control wiring. Wire the cable directly to the 8-pin resolver connector on the 
M4500. Refer to the electrical control schematic at the back of this manual for details. 
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________________________________________________________________________________ 
2.3 HSL-ANCNF SOFTWARE INSTALLATION 
 
Follow the steps below to install either the Windows or DOS based setup programs and PLC 
application program on a laptop or personal computer used to support the HSL-ANCNF control 
system. 
 
 
________________________________________________________________________________ 
2.3.1 WINDOWS™ BASED SETUP PROGRAM INSTALLATION 
 
The Windows based ANCNF setup program is compatible with Windows 95/98/ME/2000/XP 
operating systems and is used to: 
 1) Setup (tune) the user adjustable variables. 
 2) Adjust the timing channel set-points. 

3) Download the application program to the M4500 module. 
4) Download (restore) or upload (save) the user setup variables from the M4500. 
5) View “Shift” production data and station transfer jams.  

 
To install the set-up software, perform the following steps: 
 

1) Insert the CD into the drive 
 

2) From the Windows desktop, “Click” Start and then select run. 
 

3) From the “Run” dialog box, “Click” the Browse button.   
 

4) Select the drive with CD.  Select the “setup.exe” file and “Click” Open and then Ok. 
 

5) This will initiate the installation process.  Follow the instructions that appear on the screen to 
complete the installation process.  The ANCNF setup program can be executed from the 
“Systems” folder located in Programs. 
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________________________________________________________________________________ 
2.3.2 DOS BASED SET-UP PROGRAM INSTALLATION 
 
The DOS based HSLANF set-up software is used to:  

1) Download the application program to the M4500 module . 
2) Tune (set-up) the user adjustable variables of the HSL-ANCNF  
3) Download and upload (save) the user setup variables from the M4500 to disk. 
4) View jams per station and shift data . 

 
To install the set-up software, perform the following steps: 
 
1) Create a directory off the root for each necker/flanger. These will be used to store the 

“HSLANCNF.EXE” setup programs and HSLANCNF set-up data for each machine.  
 

Create these directories by typing the following at the DOS prompt: 
 

MD  \HSLNF1<ENTER> 
MD  \HSLNF2<ENTER> 
MD  \HSLNF3<ENTER> 

etc. 
 
2) Install the “PROGRAMS” into the drive. For each “HSLNF” directory you created, switch to 

that directory and install the “HSL-ANCNF” set-up programs by typing the following at the 
DOS prompt (Line 1 necker/flanger is shown): 

 
CD  \HSLNF1<ENTER> 
A:INSTALL<ENTER> 

 
3) Add each necker/flanger's HSL-ANCNF set-up program to your computer's menu software by 

creating a selection for each necker/flanger called “SET-UP N/F LINE1” for the line #1 
necker/flanger, “SET-UP N/F LINE2” for the line #2 necker/flanger, etc.. The DOS commands 
executed for these selections should be (Line 1 necker/flanger is shown): 

 
For the “SET-UP N/F LINE1” selection: 

CD  \HSLNF1 
HSLANCNF  HSLANCNF 
CD  \ 

 
4) To execute the respective necker/flanger's set-up program, simply select the corresponding 

“SET-UP N/F LINE” selection from the menu software's menu. 
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________________________________________________________________________________ 
2.3.3 APPLICATION PROGRAM INSTALLATION 
 
The HSLANCNF application program is a SYSdev based program, loaded into the M4500 module 
and performs the HSL-ANCNF logic. The program is written in a combination of Ladder logic and 
High-level. If the user desires to make program changes or perform on-line monitoring of the 
program execution the files, which constitute the HSLANCNF program, will have to be loaded onto 
the hard drive of the PC used to support the system. The SYSdev Program Development Software 
will also have to be loaded on the PC. To install this program perform the following: 
 
1) Install the “PROGRAMS” disk into the drive.  
 
2) For each of the “HSLNF1” directories (created in section 2.3.2 – DOS Setup Program 

Installation), copy all the files from the disk to each of these subdirectories. 
 
 
________________________________________________________________________________ 
2.3.4 SYSdev PROGRAM DEVELOPMENT SOFTWARE INSTALLATION 
 
The SYSdev Program Development software is used to perform on-line trouble-shooting and 
program modifications to the HSL-ANCNF. If SYSdev was purchased with the control system and 
is not already installed on the your computer, install SYSdev onto the hard drive of your computer 
following the steps outlined in the SYSdev Program Development manual. 
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________________________________________________________________________________ 
2.4 TUNING THE HSL-ANCNF 
 
The HSL-ANCNF is shipped from the factory with the PLC program “HSLANF” loaded in the 
M4500 module (PLC section) and the PLS channel set-point file “ANCNFTMG” loaded in the PLS 
section. These are the standard programs used to implement the standard necker/flanger algorithms. 
In addition, as shipped, the user variables are set to the following defaults: 
 

Number of Shifts (to each station): 
Station #1.......................: 020 
Station #2.......................: 040 
Station #3.......................: 060 
Station #4.......................: 080 
Station #5.......................: 100 
Station #6.......................: 120 
Station #7.......................: 140 
Station #8.......................: 160 
Station #9.......................: 180 
Station #10.....................: 200 
Flanger...........................: 220 

 
Number of Missing Cans for Transfer Jam Alarm: 

Station #1.......................: 005 
Station #2.......................: 005 
Station #3.......................: 005 
Station #4.......................: 005 
Station #5.......................: 005 
Station #6.......................: 005 
Station #7.......................: 005 
Station #8.......................: 005 
Station #9.......................: 005 
Station #10.....................: 005 
Flanger...........................: 005 

 
The “ANCNFTMG” timing channel file, as shipped, contains the following default timing set-
points: 

 
CHAN ON - OFF DESCRIPTION 
 
CH00: 180 - 240 Transfer Timing 
CH01: 090 - 270 PLC Clock Timing 
CH02: ___ - ___ 
CH03: ___ - ___ 
CH04: ___ - ___ 
CH05: ___ - ___ 
CH06: ___ - ___ 
CH07: ___ - ___ 

 
In most cases, the above user variables and timing channels will have to be altered to tune the HSL-
ANCNF to the actual necker/flanger it is controlling. 
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Once installed and the control system is powered back up, perform the following to set-up and tune 
the HSL-ANCNF. The set-up is performed using either the Keypad/Display or a PC running the set-
up program. See section 3 of this manual for a description of the Keypad commands and menu 
displays of the Keypad/Display. See sections 4 and 5 for a description of menus and how to use the 
set-up programs. 
 
 
________________________________________________________________________________ 
2.4.1 SET MACHINE ZERO 
 
Zero machine (set resolver offset).  Using the Keypad/Display, perform the following: 
 
1) Select “3: SET MACHINE TIMING” and observe the “POS:” field. Verify that as the machine 

is rotated forward that the position increases linearly from 0 through 359. If not, swap the S1 and 
S3 leads of the resolver at the M4500 resolver connector. Then verify that the position then 
indeed does increase with forward movement. Press “ESC” to exit back to the primary set-up 
menu. 

 
2) Position the machine at machine zero. 

 
3) Auto zero the resolver by selecting “4: ZERO MACHINE” from the primary set-up menu. Enter 

“0” to zero the resolver. The timing set-up menu will be displayed, now showing the “POS:” at 
zero. The M4500 will calculate the actual offset value required to make this the 000 position and 
will display this number in the offset field. 

 
4) Exit back to the primary set-up menu by pressing <ESC>.  Press <ESC> again to exit back to 

the default screen. 
 
 
________________________________________________________________________________ 
2.4.2 SET MACHINE TIMING 
 
Set the Transfer Jam timing signal (CH00) such that it transitions from “off” to “on” when cans are 
centered in the middle of the transfer sensors and infeed sensor. Although only the leading edge 
(“off” to “on” transition) is used, CH00 should still be programmed “ON” for at least 40 degrees. 
 
The PLC Can Clock (CH01) is provided for the host PLC as a general timing signal to clock once 
per can and is not used by the control system. CH01 should be programmed “on” for 180 degrees 
and “off” for 180 degrees but can otherwise be programmed to start anywhere as desired. 
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________________________________________________________________________________ 
2.4.3 VERIFY LOCATION OF INFEED AND TRANSFER SENSORS 
 
The infeed and Transfer sensors must turn “on” at least 50 degrees before the “off” to “on” 
transition of the Transfer Timing signal (CH00) and must be “on” at least 20 degrees after this same 
location. This guarantees that the cans will be clocked in properly by each sensor. All the transfer 
sensors and infeed sensor should be located to see the cans at the same time as well. If this is not the 
case, adjust each sensor accordingly or the Transfer Timing Signal (CH00). 
 
 
________________________________________________________________________________ 
2.4.4 CALIBRATE NUMBER OF SHIFTS TO EACH STATION 
 
The HSL-ANCNF control system incorporates a feature to automatically determine the number of 
shifts from the Infeed Screw sensor to each stations transfer sensor. These “Calibration Counts” can 
then be entered in as the “Number of Shifts” for each station. To determine the number of shifts to 
each station, perform the following: 
 
1) Close the Infeed and run the machine completely empty of cans.  
 

Note: The machine must be empty of cans prior to initiating the calibration otherwise the 
calibration count numbers determined will be incorrect. 

 
2) From the Keypad/Display, select “Set-Up” then “5: CALIBRATE NUMBER SHIFTS TO 

STATIONS” and press “0” to start the calibration. 
 
3) While slowly running the machine, open the infeed. The “Calibration Counts” will start 

incrementing once the first can has passed the infeed screw sensor. Each count will continue to 
increase until the first can has reached the corresponding transfer sensor at that station. This is 
the exact number of shifts from the infeed screw sensor to that station. 

 
4) Continue running the machine until the cans have reached the flanger transfer sensor (flanger 

calibration count stopped incrementing). The number of shifts to each station has now been 
determined and the calibration mode will be exited. The “Calibration Count” numbers are saved 
in battery-backed RAM and can be used at a latter time if desired. They are only reset when the 
calibration mode is entered. 

 
Note: The calibration counts are only accurate if the following conditions are true:  

• All the transfer sensors are fully functional and located properly. 
• No cans fail to transfer properly (transfer jam) while the calibration takes place.  
 

If a jam does occur or any sensor fails to operate properly, the problem will need to be corrected 
and the calibration performed again.  
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5) The “Calibration Counts” are not automatically copied to the “Number of Shifts” to each station 
variables at the end of the calibration . The user must copy the “Calibration Counts” over to the 
“Number of Shifts” manually. This allows the user to review the “Calibration Counts” for 
reasonableness prior to setting the “Number of Shifts” variables. 

 
 
________________________________________________________________________________ 
2.4.5 SET NUMBER OF SHIFTS TO STATIONS 
 
The “Number of Shifts” to each necker/flanger station are the presets used in the transfer shift 
register to enable the transfer jam detection.  
 
When the infeed screw sensor first sees cans, each station will then expect to see cans the 
corresponding number of shifts latter. These numbers can be set from the set-up menu of the HSL-
ANCNF Keypad/Display or using the set-up program. 
 
The transfer jam detection for stations 6 through 10 can be individually disabled by setting the 
“Number of Shifts” for the respective station to “0”. This is provided for machines that are not 
equipped with these stations. Setting a number between 1 to 319 enables the transfer jam detection 
for that respective station with the shift number equal to the number entered. The transfer jam 
detection for stations 1 through 5 and the flanger cannot be disabled. 
 
The numbers entered for the “Number of Shifts” should be the same as the “Calibration Counts”. 
See section 3.5.1 (using the Keypad/Display), section 4.5.2 (Windows setup program reference) or 
section 5.1 (DOS setup program reference) for details on setting the “Number of Shifts”. 
 
 
________________________________________________________________________________ 
2.4.6 SET NUMBER OF MISSING CANS FOR TRANSFER JAM ALARM 
 
These variables are the number of consecutive missing cans (once cans should be at the transfer 
sensor for that station as set in the “Number of Shifts”) that will cause a transfer jam for each 
respective station. Each station can be set independently. If the Number of missing cans is set to 4 
for a particular station, a transfer jam will be generated when four or more consecutive missing cans 
are detected at that station. If three or less consecutive missing cans occurred, the transfer jam 
would not be generated. 
 
See section 3.5.2 (using the Keypad/Display), section 4.5.2 (Windows setup program reference) or 
section 5.2 (DOS setup program reference) for details on setting the “Number of Missing Cans for 
Transfer Jam Alarm”. 
 
 

The HSL-ANCNF Is Now Set-Up And Ready To Run! 
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________________________________________________________________________________ 
2.5 M4500/P4500/D4591 INSTALLATION 
 
The following is provided only as a reference. These steps are performed by the factory prior to 
shipping the HSL-ANCNF. These steps need only be performed in the event either the M4500 
module, P4500 power supply, or D4591 display need to be replaced. Refer to the M4500 User's 
Manual for general details on installing the M4500, P4500, and D4591. 
 
 
________________________________________________________________________________ 
2.5.1 M4500 MODULE INSTALLATION 
 
To install the M4500 module, perform the following: 
 
1) Remove the cover from the M4500 chassis (retained with two captive screws on the lower front 

of the cover and two captive screws on each side of the M4500 chassis). 
 
2) Install S4563 (SLOT0-0): Set the slot address dip switches (SW1) on the S4563 to the following 

positions (slot0): 
 

S4563:  SW1 switch1 = “OFF” 
SW1 switch2 = “OFF” 

 
Install the S4563 in Slot0-0 (furthest left slot) of the M4500 chassis. 

 
 
3) Install S4573 (SLOT0-1): Set the slot address dip switches (SW1) on the S4573 to the following 

positions (slot1): 
 

S4573:  SW1 switch1 = “ON” 
SW1 switch2 = “OFF” 

 
Install the S4573 in Slot0-1 (slot next to S4563) of the M4500 chassis. 

 
 
4) Install S4573 (SLOT0-2): Set the slot address dip switches (SW1) on the S4573 to the following 

positions (slot2): 
 

S4573:  SW1 switch1 = “OFF” 
SW1 switch2 = “ON” 

 
Install the S4573 in Slot0-2 (slot next to the other S4573) of the M4500 chassis. 
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5) Install S4516 (SLOT0-3) (OPTIONAL): Set the slot address dip switches (SW2) on the S4516 
to the following positions (slot3): 

 
S4516:  SW2 switch1 = “ON” 

SW2 switch2 = “ON” 
 

Set the RS-232/RS-422 select dip switches (SW1) on the S4516 to the following positions (RS-
232 selected): 

 
S4516:  SW1 switch1 = “ON” 

SW1 switch2 = “OFF” 
 

Install the S4516 in Slot0-3 (slot next to S4573) of the M4500 chassis. 
 
 
6) Install the cover back over the M4500, making sure all the board connectors protrude through 

the slots in the cover. Tighten the two captive screws on the lower front of the cover and the two 
captive screws on each side of the M4500 chassis. 

 
7) Connect the display ribbon cable to the connector on the back of the M4500. 
 

Note: The connector on the cable is polarized. It will only mate with the connector on the 
M4500 in only one way. 

 
8) Mount the M4500 chassis to the HSL-ANCNF back panel using four 8-32 screws. 
 
9) With power to the P4500 “off”, install the P4500 power supply cable to the +5/C/+12/C/-12 

connector on the M4500.  
 
 Note: The connector on the cable is polarized. It will only mate with the connector on the 

M4500 in only one way. 
 
10) Install the respective field wiring arms on all the I/O boards of the M4500 (I/O slots0 thru 2, 

MODBUS connector on USER PORT, resolver connector, and IN0/IN1 connector). Make sure 
all the field wiring connectors are fully mated. 
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________________________________________________________________________________ 
2.5.2 P4500 POWER SUPPLY INSTALLATION 
 
To install the P4500, perform the following steps: 
 
1) Mount the P4500 to the HSL-ANCNF in the mounting holes next to the M4500 (left side) using 

two 8-32 screws. 
 
2) With power to the P4500 “off”, install the P4500 power supply cable to the +5/C/+12/C/-12 

connector on the M4500. 
 
 Note: The connector on the cable is polarized. It will only mate with the connector on the 

M4500 in only one way. 
 
 
________________________________________________________________________________ 
2.5.3 D4591 KEYPAD/DISPLAY INSTALLATION 
 
To install the D4591, perform the following steps: 
 
1) With the gasket installed on the mounting studs of the D4591, install the D4591 in the cut-out 

either in the HSL-ANCNF enclosure or the cut-out in the user's existing control cabinet (refer to 
the mechanical layout drawing at the back of the manual). Secure the display to the enclosure 
using 7ea. 8-32 nuts and external lock washers. 

 
2) Connect the display ribbon cable to the connector on the lower back of the display (the 

connector on the cable is polarized and should mate with connector on the M4500 only one 
way). 
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________________________________________________________________________________ 
2.5.4 DOWNLOAD APPLICATION PROGRAM AND SET-UP DATA TO M4500 
 
Once the M4500/P4500/D4591 are installed, perform the following to download the HSLANCNF 
application program to the M4500 as well as download the previously saved set-up data and timing 
channel set-points: 
 
1) Power up the M4500 and the IBM PC or compatible used to interface with the HSL-ANCNF. 
 
2) Connect an RS-232 cable from the computer COM port to the “PROG” port on the M4500. 
 
3) Using the setup program, download the application program to the M4500. A prompt will be 

displayed verifying the download. See section 4.2.3 (Windows setup program reference) or 
section 5.7 (DOS setup program reference) for complete details. 

 
4) Download the previously saved to disk set-up data to the. See section 4.2.4 (Windows setup 

program reference) or section 5.8 (DOS setup program reference) for complete details. 
 
5) Download the PLS timing set-points to the M4500. 
 
6) Zero the machine (set the resolver offset). 
 
7) The M4500 is now ready to run, loaded with the application program, timing set-points, and set-

up data that was previously saved for the respective necker/flanger. 
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The keypad of the HSL-ANCNF contains 24 keys consisting of data display commands, set-up 
commands, and a numeric keypad. The display of the HSL-ANCNF is 2 line by 40 character back-lit 
LCD display which displays the selected data and set-up menus. The keypad/display can be used by 
the operator to view data and can be used by authorized personnel (key switch protected) to adjust 
the timing and all set-up parameters. 
 

 

 
 
The display/keypad allows the following to be viewed or adjusted: 
 

1) Set Number of Shifts to Stations 
2) Set Transfer Jam Count Presets 
3) Set Machine Timing 
4) Set Machine Zero 
5) View the Number of Transfer Jams per Station 
6) View the Current Shift Data 
7) View the Last Shift Data 

 
 
The definitions of the keypad commands and menus are described in the following sections.  
 
Note: For virtually all the menus, the “NEXT” and “PREV” keys can be used to advance to the 
next item of the menu or retard to the previous item on the menu. 
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________________________________________________________________________________ 
3.1 DEFAULT SCREEN 
 
The default screen (displayed when no other commands are active) contains the following data: 
 

MACHINE SPEED (CPM):xxxx 
GOOD CANS:xxxxxxx       TOTAL JAMS:xxxxxx 

 
Where the “Machine Speed” is the current speed of the necker/flanger, the “Good Cans” field is the 
total number of good cans necked and flanged so far into the current shift, and the “Total Jams” 
field is the total number of transfer jams for all stations so far into the current shift. This display 
effectively replaces a speed meter, and two can counters. This screen is always returned to when no 
commands are active. 
 
 
________________________________________________________________________________ 
3.2 “JAMS PER STATION” KEY 
 
The number of transfer jams per station menu is provided to aid in the trouble-shooting of a transfer 
jam problem with a particular station. The total number of transfer jams for each station since the 
last reset or end of shift is displayed. The operator can reset these counts at any time to aid in the 
trouble-shooting process. The data can be viewed simply be pressing this key. The display shows a 
series of screens each with four stations from 1 through 10 and the flanger as shown below: 
 

-- TRANSFER JAMS PER STATION -- 
1:xxxx       2:xxxx        3:xxxx        4:xxxx 

 
Where the numbers 1 through 4 are the first 4 stations and the “xxxx” would be the actual counts for 
the respective stations. Screens for stations 5 thru 8, 9 thru flanger are shown in this fashion each for 
a time delay of 10 seconds. In addition, the user can advance to the next screen or retard to the 
previous screen by pressing the “NEXT” or “PREV” key respectively. 
 
The final screen of this menu, prompts the user to reset the counts by pressing “0” or not to by 
pressing “ESC”. This provides the operator with the opportunity to reset the counts if desired for 
trouble-shooting. If the counts are to be reset, press the “0” key, if not, press the “ESC” key. The 
default screen will now be displayed again. 
 
The “ESC” key can also be used at any time to abort the jams per station data display and return 
back to the default screen. 
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________________________________________________________________________________ 
3.3 “CURRENT SHIFT” KEY 
 
The Current shift data menu displays the following information: 
 

• Good Cans: 
• Total Jams: 
• Transfer Jams per Station (1-Flanger): 

 
This data is the totals so far into the shift. This data is transferred to the “Last shift” data when the 
end of shift input transfers from a “0” to a “1”. This can be at the end of either an 8 or 12 hour shift 
or alternatively could be done at label changes such the data collected would be for label runs rather 
than complete shifts. This data cannot be reset by the operator, only at the end of shift input 
transition.  
 
Note: The Current shift “Good Cans” and “Total Jams” is displayed as part of the default screen. 
 
Good Cans: This is the total number of good cans necked and flanged so far into the shift. This is 
essentially a can counter. 
 
Total Jams: This is the total number of transfer jams for all stations of the machine. 
 
Transfer Jams per Station (1:-Flanger:): This is the total transfer jams for each station. A 
disproportionately high count for a particular station indicates a transfer jam problem for that 
station. 
 
 
________________________________________________________________________________ 
3.4 “LAST SHIFT” KEY 
 
The “Last Shift” data is identical to the current shift data except it is for the previous 8 or 12 hour 
shift or previous label run, how ever the shift collection is set-up. This allows data collection and 
diagnostics to take place automatically over a two shift period.  
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________________________________________________________________________________ 
3.5 “SET-UP” KEY 
 
This selection is used to invoke the primary set-up menu. This consists of the following five 
selections: 
 

1: SET NUMBER OF SHIFTS TO STATIONS 
2: SET TRANSFER JAM COUNT PRESETS 
3: SET MACHINE TIMING (SET-POINTS, ETC.) 
4: ZERO MACHINE (SET RESOLVER OFFSET) 
5: CALIBRATE NUMBER SHIFTS TO STATIONS 

 
The set-up menu is key switch protected such that only authorized personnel (those with the key) 
can activate the selection. The “Set-up Enable” input must be “on” to invoke the set-up menu. When 
selected, each of the above selections bring up a sub-menu with the corresponding set-up 
parameters. The following sections describe these sub-menus and the definitions of the 
corresponding variables. To select the respective set-up sub-menu, simply press the corresponding 
numeric key (1 thru 5). 
 
 
________________________________________________________________________________ 
3.5.1 SET NUMBER OF SHIFTS TO STATIONS 
 
This menu is activated when the “1” key (SET NUMBER OF SHIFTS TO STATIONS) is pressed 
while the primary set-up menu is active. The following set-up parameters may then be adjusted or 
viewed for each station (see section 2.4.4 – Calibrate Number of Shifts to each Station for more 
details): 
 
CALIBRATION COUNT (Stations 1 thru 10 and Flanger): These are the actual number of 
shifts from the infeed screw sensor to the transfer sensor for each respective station. These numbers 
are determined when the calibration is performed. These numbers cannot be changed in this menu, 
only viewed. 
 
NUMBER OF SHIFTS (Stations 1 thru 10 and Flanger): This is the number of shifts from 
the infeed screw sensor to the transfer sensor for each station. These numbers can be determined 
using the calibration mode or they could be counted manually if desired. The range of values for 
these numbers is 1 to 319. In addition, the transfer jam detection for stations 6 thru 10 can be 
disabled by setting the “number of shifts” for the respective station to “0” (stations 1 thru 5 and the 
flanger cannot be disabled). This would be done on machines not equipped with these stations. 
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The “NEXT” and “PREV” keys can be used to advance to the next station or the previous station 
respectively. To change the displayed “Number of Shifts” for the current station, simply enter the 
new value on the numeric keypad and press <ENTER>. The value will be entered and the next 
station will automatically be displayed. When the “number of shifts” for the flanger is entered, the 
primary set-up menu is again displayed. Pressing <ESC> at anytime will also exit you back to the 
primary set-up menu.  
 
Note: All “number of shifts” entered must be in the range of 1 to 319 (except stations 6 thru 10 
which may be disabled by entering “0”). 
 
 
________________________________________________________________________________ 
3.5.2 SET TRANSFER JAM COUNT PRESETS 
 
This menu is activated when the “2” key (SET TRANSFER JAM COUNT PRESETS) is pressed 
while the primary set-up menu is active. The following set-up parameters may then be adjusted or 
viewed: 
 
NUMBER OF MISSING CANS FOR TRANSFER JAM (Stations 1 thru 10 and Flanger: 
These variables are the number of consecutive missing cans (once cans should be at the transfer 
sensor for that station as set in the “Number of Shifts”) that will cause a transfer jam for each 
respective station. Each station can be set independently. If the Number of missing cans is set to 4 
for a particular station, a transfer jam will be generated when four or more consecutive missing cans 
are detected at that station. If three or less consecutive missing cans occurred, the transfer jam 
would not be generated. 
 
The “NEXT” and “PREV” keys can be used to advance to the next station or the previous station 
respectively. To change the currently displayed parameter, simply enter the new value on the 
numeric keypad and press <ENTER>. The value will be entered and the next station will 
automatically be displayed. When the number of missing cans for the flanger is entered , the primary 
set-up menu is again displayed. Pressing <ESC> at anytime will also exit you back to the primary 
set-up menu. 
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________________________________________________________________________________ 
3.5.3 SET MACHINE TIMING (SET-POINTS, ETC.) 
 
This selection brings up the timing set-point menu which displays the following fields: 
 

CHuu  SETPOINT:xxx   []  “channel name” 
RPM:yyyy    POS:zzz     OFFSET:wwww  SCALE:360 

 
Each field is defined as follows: 
 
Field Definition 
Chuu Currently selected channel (CH00 thru CH07) where “uu” is the octal channel 

number. 
 
SETPOINT:xxx Channel “on” or “off” set-point where “xxx” is the set-point position 
 
[] State of channel set-point (blank = “off”, solid block character = “on”) 
 
“channel name” selected channel name: (CH00) TRANSFER TIMING, (CH01) PLC CLOCK 

TIMING, etc. 
 
RPM:yyyy Current machine speed where “yyyy” is in CPM. 
 
POS:zzz Current resolver position where “zzz” is in degrees. 
 
OFFSET:wwww Resolver offset where “wwww” is the offset in degrees. 
 
SCALE:360 Resolver SCALE FACTOR (360 degrees per revolution). 
 
In addition to displaying the timing set-point menu, the following keys are also enabled: “ENTER 
SET-POINT”, “CLEAR CHANNEL”, “SELECT CHANNEL”, and “SEARCH CHANNEL”. 
 
The “ENTER SET-POINT” key is used to enter a new set-point (both “on” and “off” set-points) in 
the selected channel. The “CLEAR CHANNEL” key is used to clear all set-points from the selected 
channel. The “SELECT CHANNEL” key is used to select a new channel for programming. The 
“SEARCH CHANNEL” is used to view both the “on” and “off” set-points in the selected channel. 
 
Searching Channel: To view the set-points in a channel simply press the “SEARCH 
CHANNEL” key. The next “off” to “on” or “on” to “off” position is shown in the “SETPOINT” 
field. If the transition was “off” to “on”, the state character [] will be a solid block. If the transition 
was “on” to “off”, the state character [] will be blank. 
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Entering or Adjusting Set-point: To set or adjust a timing channel, perform the following: 
 
1) Select the channel to be adjusted by pressing the “SELECT CHANNEL” key, entering the 

channel number (00 to 17) and pressing enter. In addition, the “NEXT” and “PREV” keys can be 
used to advance to the next channel or retard to the previous channel. 

 
2) Press “CLEAR CHANNEL” to clear the existing set-point out. 
 

Note: Entering a new set-point does not automatically clear the old set-point out. If the two set-
points are not in the same place, the channel will simply have two set-points in it if the old one 
is not cleared out first. Therefore always clear the channel before entering a new set-point. A set-
point may, however, be “extended” by programming another set-point onto an existing set-point 
using either the existing “on” or “off” set-point as the starting position for the new set-point. 
This will result in one larger set-point. 

 
3) Press “ENTER SET-POINT” to enter the new set-point. The display will then prompt ““ON” 

SETPOINT:”. Enter the position (in degrees) where the set-point should go “on” and press 
<ENTER>. The display will now prompt ““OFF” SETPOINT:”. Enter the position (in degrees) 
where the set-point should go “off” and press <ENTER>. The channel will now be programmed 
with a set-point that goes “on” at the “on” position entered and “off” at the “off” position 
entered. 

 
4) Exit back to the primary set-up menu by pressing <ESC>. Exit back to the default screen by 

pressing <ESC> again. 
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________________________________________________________________________________ 
3.5.4 ZERO MACHINE (SET RESOLVER OFFSET) 
 
This selection is used to auto zero the resolver. To set the machine zero (resolver offset) perform the 
following: 
 
1) Select “3: SET MACHINE TIMING” and observe the “POS:” field. Verify that as the machine 

is rotated forward that the position increases linearly from 0 through 359. If not, swap the S1 and 
S3 leads of the resolver at the M4500 resolver connector. Then verify that the position then 
indeed does increase with forward movement. Press “ESC” to exit back to the primary set-up 
menu. 

 
2) Position the machine at machine zero. 
 
3) Auto zero the resolver by selecting “4: ZERO MACHINE” from the primary set-up menu. Enter 

“0” to zero the resolver. The timing set-up menu will be displayed, now showing the “POS:” at 
zero. 

 
4) The M4500 will calculate the actual offset value required to make this the 000 position and will 

display this number in the offset field. 
 
5) Exit back to the primary set-up menu by pressing <ESC>. Exit back to the default screen by 

pressing <ESC> again. 
 
 
________________________________________________________________________________ 
3.5.5 CALIBRATE NUMBER SHIFTS TO STATIONS 
 
This selection is used to enter the calibration mode (see section 2.4.4 – Calibrate Number of Shifts 
to each Station, for details on performing the calibration). When selected, the display will prompt 
for “0” to enter the calibrate mode or “ESC” to return back to the primary set-up menu. Press “0” to 
enter the calibration mode. The “Calibrate Counts” will be reset and “Calibration In Progress, 
Current Shift Count From Infeed” will be displayed. 
 
As the machine is run with the can feed open, the “Current Shift Count From Infeed” will display 
the number of shifts that the first can fed in is past the infeed screw sensor. When the first can 
reaches the flanger transfer sensor, the calibration is complete and the display will return to the 
primary set-up menu. The “Calibration Counts” will now be set and can be used to enter the 
“Number of Shifts” to each sensor (see section 3.5.1 – Set Number of Shifts to Stations). 
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The Windows based set-up program is menu driven, allowing the user to easily view data, alter set-
up variables or set machine timing (machine offset, timing signal locations, etc.), using a PC 
running the Windows (95/98/ME/2000/XP/NT) operating system. The set-up variables are used to 
configure and tune the M4500 to match the configuration and performance of the specific 
necker/flanger (see section 2.4 – Tuning the HSL-ANCNF). 
 
Note:  The set-up program is an on-line communications program used to interface with the M4500 
module.  The data displayed and set in the windows is communicated directly to the module, while 
in the “Online” edit mode. Therefore, prior to going online with the processor, make sure an RS-232 
cable is connected from the COM port on the computer to the “PROG” port on the M4500.  The 
variables displayed while in the “Online” edit mode are read directly from the processor.  Data is 
saved to a “Set-up Data” file (*.sdt) whenever changes are made to a parameter or if the data is 
uploaded from the processor. 
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________________________________________________________________________________ 
4.1 GENERAL DESCRIPTION 
 
Title Bar:  At the top of the window is the “Title Bar”.  The title bar is used to display the name of 
the working “Set-up Data” file, as well as, the name of the active “Window”.  The title bar is dark if 
the window is active and grayed if another window is active.  The color depends on the settings of 
the Display Properties of the Control Panel. 
 
Status Bar:  At the bottom of the window is the “Status Bar”.  The status bar is used to display 
system messages, online or offline mode, as well as, the current time and date as set by the operating 
system.  The system messages panel displays general information about operation of the system.  
The Online/Offline mode panel displays the status of the current set-up program mode of operation.  
The mode of operation can be changed by simply double clicking the online/offline mode panel. 
 
Hot Keys:  Hot keys are activated by holding down the “ALT” key and simultaneously pressing the 
underlined letter of the desired function.  Almost every function can be activated by either pressing 
a series of hot keys or using the “TAB” key to move between fields. 
 
Online/Offline Modes:  The set-up program allows the user to make changes while “Online” with 
the processor.  The “Offline” mode is used to preset parameters prior to download.  All functions 
are available to the user while “Online”, however, specific “Online” functions are disabled in the 
“Offline” edit mode. 
 
Note:  Offline changes can only be made by enabling “Offline Editing”, accessed under the “Edit” 
menu. 
 
Getting Help:  The entire contents of the user’s manual is contained within the help file.  Pressing 
Ctrl+H will display the help file window.  Pressing the F1 key will display the contents file.  Hot 
spots allow jumps to other topics to display additional information as desired.  Selecting About 
ANCNF from the Help menu will display a dialog box listing information about the current revision 
of the setup program and how to obtain technical support. 
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________________________________________________________________________________ 
4.2 THE FILE MENU 
 
The “File” menu allows the user to perform the following functions: 
 
• Create a “New” set-up “Data File”. 
• Open an existing “Data File”. 
• Save any changes made to the current “Data File” to disk. 
• Upload (save) Data from the Processor. 
• Download a SYSdev (.sdv) program to the processor 
• Download (restore) Data from the current set-up “Data File” to the processor 
• Print a Report of the current set-up parameters. 
• Exit the set-up program 
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________________________________________________________________________________ 
4.2.1 THE SET-UP DATA FILE 
 
The set-up “Data File” (.sdt) is a binary access file, designed for fast file I/O operation.  When the 
set-up program is first invoked, the default set-up parameters are loaded into memory.  If changes 
are made to any of the set-up parameters (either online or offline), as well as shift data, the user will 
be flagged to “Save Changes” upon exit of the program. 
 
Note:  Any windows based “Set-up” program can open a set-up “Data File”, however, the data 
tables will not be properly aligned.  The user will be alerted to the problem if a set-up data file has 
been created by either a different set-up program or a different revision of the software. 
 
The set-up “Data File” is similar to that of a word processing file.  When the program first starts a 
default file is loaded and the user is able to make any changes as desired.  The set-up program is 
unaware of the settings and parameters that exist within the M4500.  Therefore, to normalize the 
set-up program with the processor, the user should define or open an existing file, then upload “All” 
variables from the processor.  This allows the user to either create a backup of the data or maintain 
an existing file.  The user can even open a data file for another necker/flanger, save the file to a new 
name, make the necessary changes and simply download the new parameters to another processor. 
 
The following functions can be accessed any time, from any set-up or display windows. 
 
New:  To create a “New” data file, select “New” from the “File” menu or press “Ctrl + N”.  This 
creates a completely new file, loaded with the default variables and the word “[unnamed]” is 
displayed in the title bar.  If any changes were made to the existing file, the user is prompted to save 
changes to the existing file. 
 
Open:  To “Open” and existing data file, select “Open” from the “File” menu or press “Ctrl + O”.  
This displays a dialog box allowing the user to select an existing data file to open. The name of the 
file will be displayed in the title bar.  If any changes were made to the existing file, the user will be 
prompted to save any changes before terminating the program. 
 
Save:  To “Save” data file to disk, select “Save” from the “File” menu or press “Ctrl + S”.  This 
displays a dialog box allowing the user to select a folder and enter a name for the file.  The user will 
be notified if the file already exists and the extension “.sdt” will automatically be added to the file 
name.  If this is a “New” file, the user will be prompted to enter a file name. 
 
Save As:  To save the data file to a new name, select “Save As” from the “File” menu..  This 
displays a dialog box allowing the user to select a folder and enter in a new name for the file.  The 
user will be notified if the file exists and the extension “.sdt” will automatically be added to the file 
name. 
 
Export Shift Data…:  This function allows the user to export the shift data to a “Tab Delimited” 
text file.  This allows the user to easily use the shift data to produce production reports. 
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________________________________________________________________________________ 
4.2.2 UPLOAD (SAVE) DATA 
 
The “Set-up” program allows the user set-up parameters, timing channel set-points and shift data 
from the M4500 into a set-up “Data File”.  This function is accessed from the “File”. 
 
 
________________________________________________________________________________ 
4.2.3 DOWNLOAD PROGRAM 
 
The “Set-up” program allows the user to “Download” any SYSdev program file to the M4500. 
 
Note:  To “Download” a SYSdev program to the processor, the program must be “Online”.  If 
“Online” mode cannot be achieved, program download will not be executed.  If the program is 
currently “Offline”, the user will be prompted to first go “Online”. 
 
Once selected, and the set-up program “Online” with the processor, a dialog box will be displayed, 
allowing the user to select the SYSdev file to download. 
 
Note:  Only the files with the “.sdv” file extension will be displayed.  It is important to keep in 
mind that only a valid M4500 PLC SYSdev file can be downloaded through the set-up program.  
Care should be taken when selecting a program to download. 
 
Once selected, a message box is displayed informing the user of the current program, revision and 
checksum of the program loaded in the processor, as well as, that of the selected program.   
 

 
 
The user must confirm their selection by clicking the “Yes” command button.  After the user 
confirms their choice, program download is initiated and the current program download address is 
displayed.  When program download is complete, the user is prompted to acknowledge.  Control is 
passed back to the main program and the set-up program remains in an “Online” edit mode. 
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________________________________________________________________________________ 
4.2.4 DOWNLOAD (RESTORE) DATA 
 
The set-up program allows the user to download  “Set-up” parameters, timing channel set-points 
and shift data to the M4500 from the set-up “Data File”.  This function is accessed from the “File” 
menu. 
 
Note:  Only the values contained within the current data file are used.  If the validity of the current 
data file is questionable, review the data in an “Offline” mode prior to download. 
 
 
________________________________________________________________________________ 
4.2.5 PRINT REPORT 
 
The “Set-up” program allows the user to generate a “Report” printout of all the set-up parameters, 
timing channel set-points and shift data.  This function is accessed from the “File” menu. 
 
At the top of each page, the report displays the name of the set-up file being printed.  At the bottom 
of each page is the date and time the data was uploaded, as well as the page number. 
 
To printout a report of the settings contained in the set-up “Data File”, perform the following: 
 
1) From the “File” menu, select “Print Report” or press “Ctrl + P”.  If the user is currently “Online” 

with the processor, the current values inside the processor will be automatically uploaded.   
 
2) The “Print Setup” dialog box will then be displayed, allowing the user to select a printer, as well 

as, the paper size and orientation.  Once the user selects “OK”, the report is generated and sent 
to the specified printer device.   

 
Note: This function makes use of the windows print manager, which allows the user to continue 
with their work while the document is being printed. 
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________________________________________________________________________________ 
4.3 THE EDIT MENU 
 
The “Edit” menu allows the user to perform the following functions: 
 
• Enable/Disable Offline Editing. 
• Set-up the Comm Port. 
 

 
 
 
________________________________________________________________________________ 
4.3.1 ENABLE OFFLINE EDITING 
 
This function allows the user to perform “Offline” editing on the currently loaded set-up data file.  
This allows the user the ability to make any necessary changes to the set-up parameters while not 
online with the processor.   
 
If offline editing is not enabled, the user is only able to view the set-up parameters and shift data.  
When the program is first invoked, the default setting is offline editing disabled.  The user will need 
to specifically select “Enable Offline Editing” from the edit menu (or press function key F2) to 
enable/disable this feature. 
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________________________________________________________________________________ 
4.3.2 SETUP COMM PORT 
 
This function allows the user to specify the serial communications port and rate to talk to the 
M4500.  The programming port of the M4500 is set to 9600 baud.   
 

 
 
Once selected, a dialog box requesting the user to select a “Comm Port” and “Baud Rate” will be 
displayed.  The default setting is COM1 at 9600 baud.  
 
In most cases the user will only need to specify the communications port and leave the baud rate at 
9600.  If communication problems occur, make sure there is a secure connection from the PC to the 
PLC.  Then check the Comm port.  In most cases the user will only need to select a new Comm port.  
If communication problems persist, there may be another program causing a conflict with the port.  
Check the port configuration from the “Settings” folder. 
 
 



SECTION 4 
ANCNF WINDOWS BASED 

SETUP PROGRAM REFERENCE 

 
HSL-ANCNF User’s Manual SYSTEMS Electronics Group 

 
- 35 - 

________________________________________________________________________________ 
4.4 THE VIEW MENU 
 
The “View” menu allows the user to perform the following functions: 
 
• View the “Target Board Interface” 
• View “Online” Data 
• View “Offline” Data 
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________________________________________________________________________________ 
4.4.1 TARGET BOARD INTERFACE 
 
This function allows the user to view fault codes, S3000 network communication error codes and 
review the current “Ident” and “Revision” of the application program.  This is accessed by the 
“View” menu, by selecting “Target Board Interface”. 
 

 
 
Once invoked, the set-up program will prompt the user to select a program to compare with the one 
existing in the processor.  Whether a program is selected or the user cancels, the setup program will 
attempt to communicate with the M4500.  If unsuccessful, a warning message will be displayed, 
prompting the user to either “Retry” or “Cancel” the operation.  If the operation is canceled and 
communication with the processor cannot be established the system will be placed in an “Offline” 
mode, however the “Target Board Interface” window will be displayed. 
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________________________________________________________________________________ 
4.4.2 VIEW ONLINE DATA 
 
This function allows the user to place the set-up program in an “Online” mode with the processor.  
This is accessed by the “View” menu, by selecting “Online Data” or by simply pressing the “F3” 
function key. 
 
Note:  The program can be toggled between “Offline” and “Online” by simply double clicking on 
the “Online” or “Offline” panel displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will attempt to open the Comm port and communicate with the 
M4500.  If the set-up program is unsuccessful, a warning message will be displayed prompting the 
user to either “Retry” or “Cancel” the operation.  If the operation is canceled and communication 
with the processor cannot be established the system will be placed in an “Offline” edit mode. 
 
Note:  Anytime while the set-up program is “Online” with the processor and communication is 
interrupted, a warning message will be displayed, prompting the user to either “Retry” or “Cancel” 
the operation. 
 
 
________________________________________________________________________________ 
4.4.3 VIEW OFFLINE DATA 
 
This function allows the user to place the set-up program in an “Offline” mode.  This is accessed by 
the “View” menu, by selecting “Offline Data” or by simply pressing the “F4” function key.  This 
allows the user to perform “Offline” editing.  All values displayed in “Offline” edit mode reflect the 
actual values contained in the currently loaded set-up data file. 
 
Note:  The program can be toggled between “Online” and “Offline” by simply double clicking on 
the “Online” or “Offline” panel displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will close the Comm port and cease communication with the 
M4500. 
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________________________________________________________________________________ 
4.5 THE WINDOW MENU 
 
The “Window” menu allows the user to select one of five different Display/Set-up windows to 
modify set-up parameters, view shift data or receive feedback about the current status of the control 
system. 
 

 
 
Once a window menu item is selected, a check mark is placed next to the selected item and the 
selected window is displayed with the name changed in the title bar of the main window. 
 
Note:  “Read” only variables are displayed in blue with a gray background.  Any variables that can 
be altered by the user are displayed in black with a white background.  In most cases, a parameter 
that can be changed by the user will have associated with it increment and decrement controls.  The 
user can either click on the desired parameter to adjust and enter in a new value, or use the 
increment or decrement controls to change the value by 1 unit. 
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_______________________________________________________________________________ 
4.5.1 THE MAIN DISPLAY WINDOW 
 
The “Main Display” window is used to display the general state of the control system.  This window 
is selected from the “Window” menu. 
 

 
 
The following is a list of the functions of the “Main Display” window. 
 
Messages:  The “Messages” display is continuously updated.  It displays alarm and status 
messages specific to the M4500, as well as, the current “Online” or “Offline” status of the set-up 
program.  By simply scrolling the display, the user is able to view all active alarm and status 
messages.  If no alarm or status messages are active, a default message is displayed. 
 
Machine CPM:  This display is only active while “Online” and displays the current speed of the 
machine in “Cans Per Minute”. 
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Current Shift Data: This data is the totals so far into the shift. This data is transferred to the “Last 
shift” data when the end of shift input transfers from a “0” to a “1”. This can be at the end of either 
an 8 or 12 hour shift or alternatively could be done at label changes such that the data collected 
would be for label runs rather than complete shifts. This data cannot be reset either from this menu 
or by the operator, only at the end of shift input transition. To exit back to the main menu, press 
<ESC>. 
 
1) Good Cans: This is the total number of good cans necked and flanged so far into the current 

shift. This is essentially a can counter. 
 
2) Total Jams: This is the total number of transfer jams for all stations of the machine. 
 
3) Station #01 Jams thru Flanger Jams: This is the total transfer jams for each station. A 

disproportionately high count for a particular station indicates a transfer jam problem for that 
station. 

 
Last Shift Data: The “Last Shift” data is identical to the current shift data except it is for the 
previous 8 or 12 hour shift or previous label run, how ever the shift collection is set-up. This allows 
data collection and diagnostics to take place automatically over a two shift period.  
 
Jams Per Station Data: The number of transfer jams per station is provided to aid in the trouble-
shooting of a transfer jam problem with a particular station. The total number of jams for each 
station since the last reset or end of shift is displayed. The user can reset these counts at any time by 
clicking on the “Reset Jams/Station” button to aid in the trouble-shooting process. 
 
Transfer Jam Alarms: The state of the station transfer jam alarm status is indicated here.  If a 
station is in alarm the text will display “ALARM”, otherwise the text will display “normal”.  This 
data is only available while the setup program is “Online”. 
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________________________________________________________________________________ 
4.5.2 THE SETUP PARAMETERS WINDOW 
 
The “Set-up Parameters” window is used to view and adjust any of the set-up parameters.  This 
window is selected from the “Window” menu. 
 

 
 
Number of Shifts (Stations 1 thru 10 and Flanger): This is the number of shifts from the 
infeed screw sensor to the transfer sensor for each station. These numbers can be determined using 
the calibration mode or they could be counted manually if desired. The range of values for these 
numbers is 1 to 319. In addition, the transfer jam detection can be disabled by setting the “number 
of shifts” for the respective station to “0”. This would be done on machines not equipped with all 
stations. 
 
Calibration Count (Stations 1 thru 10 and Flanger): These are the actual number of shifts 
from the infeed screw sensor to the transfer sensor for each respective station. These numbers are 
determined when the calibration is performed  
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Number of Missing Cans for Transfer Jam Alarm (Stations 1 thru 10 and Flanger): 
These variables are the number of consecutive missing cans (once cans should be at the transfer 
sensor for that station as set in the “Number of Shifts”) that will cause a transfer jam for each 
respective station. Each station can be set independently. If the Number of missing cans is set to 4 
for a particular station, a transfer jam will be generated when four or more consecutive missing cans 
are detected at that station. If three or less consecutive missing cans occurred, the transfer jam 
would not be generated. 
 
Transfer Jam Enable: This allows the user to disable the jam detection for a particular station 
without setting the number of shifts to “0”.  Jam detection cannot be enabled if the number of shifts 
to the station is set to zero. 
 
Calibrate Number of Shifts (reset calibration counts):  This is used to initiate the 
calibration mode. The calibration mode automatically determines the “Calibration Count” registers. 
See section 2.4.4 – Calibrate Number of Shifts to Stations for more details. 
 
Auto Set Shifts (Shifts set to Calibration Counts):  This selection copies the “Calibration 
Count” registers to the “Number of Shifts” registers when selected. This would be done after the 
calibration has been performed and the Calibration counts have been determined. This is the 
quickest and easiest way to set the “Number of Shifts” variables. 
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________________________________________________________________________________ 
4.5.3 THE MACHINE TIMING WINDOW 
 
The Machine Timing window is used to invoke the PLS programming command menus.  From this 
window, the user can view or adjust the following parameters: 
 
• Adjust Timing Channel set-points. 
• Set the resolver offset. 
• Clear or Recall a PLS timing channel. 
• View the current PLS configuration 
• Reset the PLS configuration to default settings. 
 

 
 
In addition, the following parameters are displayed at the bottom of this window: 
 
RPM:  This is the current speed in “Revolutions per Minute” of the main crank resolver. 
 
Position:  This is the current “Position” in degrees of the main crank resolver. 
 
Offset:  This is the current resolver offset (set in degrees). 
 
Scale:  This is the scale factor of the resolver or the number of divisions in one revolution. 
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Note:  The General Timing Signal Locations section provides a complete description of each 
timing channel signal. 
 
Zeroing the Machine (setting the resolver offset):  To set machine zero, perform the 
following: 
 
1) Connect an RS-232 SYSdev cable from the COM port on the computer to the “PROG” port on 

the M4500.   
 
2) From the “Window” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  The set-up program will attempt to communicate 

with the processor and place the system into an “Online” mode of operation. 
 
4) Observe the “Position” field at the bottom of the window.  Verify that as the machine is rotated 

forward, that the position increases linearly from 0 through 359 degrees.  If not, swap the S1 and 
S3 leads at the resolver connector on the M4500.  Then, verify that the position does indeed 
increase with forward movement. 

 
5) Position the machine at machine. 
 
6) Auto zero the resolver by entering “0” in the “Resolver Offset” field and clicking the “Set 

Offset” command button.  A message box will appear, prompting the user to confirm their 
choice.  Select “Yes” to set the resolver offset. 

 
7) The M4500 will calculate the actual offset value required to make this the “0” position.  The 

new offset value will be displayed in the “Offset” field and the position will then read zero. 
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Adjusting the Timing Channel Set-points:  To set any of the timing signal set-points, perform 
the following: 
 
Note:  Any changes made to the timing channel set-points will be saved as part of the setup data 
file. 
 
1) Connect an RS-232 SYSdev cable from the COM port on the computer to the “PROG” port on 

the M4510.   
 
2) From the “Window” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  The set-up program will attempt to communicate 

with the processor and place the system into an “Online” mode of operation. 
 
4) Set all channels per the section 6 – General Timing Signal Locations.  Set-points for a particular 

channel are either entered in the field or adjusted by using the increment/decrement controls. 
 

Note:  Only one set-point is used per channel.  
 
5) If a channel needs to be “Recalled” or “Cleared”, enter the desired channel number into the 

“PLS Channel” field.  Click the “Recall Channel” command button to recall the set-points.  
Click the “Clear Channel” command button the completely clear all set-points for the selected 
channel. 

  
 Note:  If a channel has been cleared or the “On” and “Off” set-points have the same setting, the 

set-point will be displayed as “*****”. 
 
Resetting the PLS Configuration:  As an aid to the user the current PLS configuration is 
displayed in the “PLS Configuration” tab of this window.  The PLS configuration should only be 
reset if a new module has been installed.  To reset the PLS configuration, click the “Reset PLS 
Config” command button.  This function only resets the PLS configuration to the default settings. 
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________________________________________________________________________________ 
4.5.4 THE SERIAL COMMUNICATIONS WINDOW 
 
The Serial Communications window is used to view the configuration and communication status of 
the S4516 serial communications board (if installed).  From this window, the user can view the 
following: 
 
• S4516 configuration status. 
• S4516 serial communication status. 
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________________________________________________________________________________ 
4.5.5 THE I/O STATES WINDOW 
 
The “I/O States” window is provided to display states of the inputs and outputs.  The control boards, 
the states of the timing channels, as well as states of the M4500 are shown.  This includes the 
interrupt inputs (IN0 and IN1), the analog I/O and the resolver.  These values are displayed as read 
by the M4500 processor. 
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The DOS based “HSLANCNF” set-up program is menu driven, allowing the user to easily view 
data, alter set-up variables or set the machine timing (machine offset, timing signal locations, etc.) 
using a laptop or personal computer. The set-up variables are used to configure and tune the HSL-
ANCNF to match the configuration and performance of the specific necker/flanger (see section 2.4 
– Tuning the HSL-ANCNF). 
 
The main menu of the “HSLANCNF” set-up program incorporates the following menu selections: 
 

 
 
Note: The “HSLANCNF” program is an on-line communications program used to interface with 
the M4500 module. The data displayed in the menus and set in the menus is communicated directly 
to the M4500. Therefore, prior to selecting any of the above selections, make sure an RS-232 cable 
is connected from the COM port on the computer running “HSLANCNF” to the “PROG” port on 
the M4500. 
 
The following sections are a complete description of the “HSLANCNF” selections and menus. 
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________________________________________________________________________________ 
5.1 SET NUMBER OF SHIFTS TO NECKER STATIONS/FLANGER 
 
The Number of Shifts set-up menu is used to set the number of shifts from the infeed screw sensor 
to each necker station and the flanger in the M4500. This menu is invoked by selecting “1: Set 
Number of Shifts to Necker Stations/Flanger” from the Main Menu. See section 2.4.4 – Calibrate 
Number of Shifts to Each Station for more details. 
 

 
 
Number of Shifts (Stations 1 thru 10 and Flanger): This is the number of shifts from the 
infeed screw sensor to the transfer sensor for each station. These numbers can be determined using 
the calibration mode or they could be counted manually if desired. The range of values for these 
numbers is 1 to 319. In addition, the transfer jam detection for stations 6 thru 10 can be disabled by 
setting the “number of shifts” for the respective station to “0” (stations 1 thru 5 and the flanger 
cannot be disabled). This would be done on machines not equipped with these stations. 
 
Calibration Count (Stations 1 thru 10 and Flanger): These are the actual number of shifts 
from the infeed screw sensor to the transfer sensor for each respective station. These numbers are 
determined when the calibration is performed. 
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The menu selections in this set-up menu allow you to set the Number of Shifts variables as well as 
perform the calibration. The menu incorporates the following selections: 
 
1: Calibrate Number of Shifts (reset calibration counts):  Used to initiate the calibration 

mode. The calibration mode automatically determines the “Calibration Count” registers.  
 
2: Set Number of Shifts to each Station:  This allows each station to be individually and 

manually set. When selected, prompts for each station are displayed. Enter the corresponding 
“Number of Shifts” for that station and press enter. 

 
3: Auto Set Shifts (Shifts set to Calibration Counts):  This selection copies the 

“Calibration Count” registers to the “Number of Shifts” registers when selected. This would be 
done after the calibration has been performed and the Calibration counts have been determined. 
This is the quickest and easiest way to set the “Number of Shifts” variables. 

 
4: Help Screen:  This help screen provides a description of the calibration procedure and the 

definitions of each menu selection. 
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________________________________________________________________________________ 
5.2 SET TRANSFER JAM ALARM COUNT PRESETS 
 
The Transfer Jam Alarm Count set-up menu is used to set the Number of Missing Cans for Transfer 
Jam Alarm for each station in the M4500. This menu is invoked by selecting “2: Set Transfer Jam 
Alarm Count Presets” from the Main Menu.  
 

 
 
Number of Missing Cans for Transfer Jam Alarm (Stations 1 thru 10 and Flanger): These variables 
are the number of consecutive missing cans (once cans should be at the transfer sensor for that 
station as set in the “Number of Shifts”) that will cause a transfer jam for each respective station. 
Each station can be set independently. If the Number of missing cans is set to 4 for a particular 
station, a transfer jam will be generated when four or more consecutive missing cans are detected at 
that station. If three or less consecutive missing cans occurred, the transfer jam would not be 
generated. 
 
The menu selection on the “Number of Missing Cans for Transfer Jam Alarm” menu allows you to 
set the presets for each station: 
 
1: Set Number of Missing Cans for Transfer Jam Alarms:  This allows each station to be 

individually and manually set. When selected, prompts for each station are displayed. Enter the 
corresponding “Number of Missing Cans for Transfer Jam Alarm” for that station and press 
enter. 

 
2: Help Screen:  This is a help screen for the “Number of Missing Cans for Transfer Jam Alarm” 

menu providing a description of the these parameters. 
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________________________________________________________________________________ 
5.3 SET MACHINE TIMING 
 
The Set Machine Timing selection is used to invoke the PLS programming command menus (these 
are the same menus used in SYSdev to program the PLS section of the M4500). When selected, the 
PLS programming main development menu will be invoked using the default ANCNFTMG channel 
set-point file. From this menu, the user can zero the machine (set the resolver offset) and adjust the 
timing signal set-points. The following sections describe how to perform these functions, section 6 – 
General Timing Signal Locations, provides a complete description of each timing signal. 
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________________________________________________________________________________ 
5.3.1 ZEROING THE MACHINE 
 
To set the machine zero (resolver offset) perform the following: 
 
1) Select the “3: Set Machine Timing” selection from the HSL-ANCNF set-up program main 

menu. 
 
2) Select “1: Online Channel Set-point Programming” from the Main Development menu. 
 
3) Select “F9: POS/RPM” and observe the “POS:” field. Verify that as the machine is rotated 

forward that the position increases linearly from 0 through 359. If not, swap the S1 and S3 leads 
of the resolver at the M4500 resolver connector. Then verify that the position then indeed does 
increase with forward movement. Press “ESC” to exit the “POS/RPM” update. 

 
4) Position the machine at machine zero. 
 
5) Auto zero the resolver by selecting “F10: Set Offset”. Enter “0” in the offset field and press 

<ENTER>.  The M4500 will calculate the actual offset value required to make this the 000 
position and will display this number in the offset field. The position will now read 0. 

 
6) Exit back to the PLS Main Development menu by pressing <ESC>. Exit back to the 

“HSLANCNF” set-up main menu by pressing <ESC> again. 
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________________________________________________________________________________ 
5.3.2 ADJUSTING THE TIMING CHANNEL SET-POINTS 
 
To set or alter any of the timing signal set-points, perform the following: 
 
1) Select the “3: Set Machine Timing” selection from the HSL-ANCNF set-up program main 

menu. 
 
2) Select “1: Online Channel Set-point Programming” from the Main Development menu. 
 
3) Set all channels per section 6 – General Timing Signal Locations. Set-points are entered for a 

particular channel simply by typing in the set-point in the form XXX-YYY<ENTER> in the first 
set-point of the given channel.  

 
Note: Up to 50 set-points may be entered for any channel. However for the necker/flanger only 
one set-point is used per channel and this should be entered in the number 1 set-point.  

 
The XXX is the location the set-point will turn “on” while YYY is the location where the set-
point will turn “off”. Use the PgUp, PgDn, F1:Next Chan, or F2: Prev Chan keys to select the 
desired channel for programming. 

 
4) Once all channels are programmed, press <ESC> to exit back to the PLS Main Development 

Menu. Press <ESC> again to exit back to the “HSLANCNF” set-up main menu. The new 
channels will be saved both in the M4500 and in the “ANCNFTMG” file on the hard drive. 
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________________________________________________________________________________ 
5.4 NUMBER OF TRANSFER JAMS PER STATION DATA 
 
The number of transfer jams per station menu is provided to aid in the trouble-shooting of a transfer 
jam problem with a particular station. The total number of jams for each station since the last reset 
or end of shift is displayed. The operator can reset these counts at any time to aid in the trouble-
shooting process. 
 
This menu is invoked by selecting “4: Number of Transfer Jams per Station” from the Main Menu.  
 

 
 
Note: Prior to selecting this selection, make sure the RS-232 cable is connected from the COM port 
on the computer to the “PROG” port on the M4500. 
 
The menu selection on the “Transfer Jams Per Station” menu allows you to reset the transfer jams 
per station counts. The selection is listed below: 
 
1: Reset Jams per Station Counts:  To reset the station jam counts, simply press “1”. The 

counts will be reset in the M4500. To exit back to the main menu, press <ESC>. 
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________________________________________________________________________________ 
5.5 CURRENT SHIFT DATA 
 
The Current shift data menu displays the following information: 
 

 
 
This data is the totals so far into the shift. This data is transferred to the “Last shift” data when the 
end of shift input transfers from a “0” to a “1”. This can be at the end of either an 8 or 12 hour shift 
or alternatively could be done at label changes such that the data collected would be for label runs 
rather than complete shifts. This data cannot be reset either from this menu or by the operator, only 
at the end of shift input transition. To exit back to the main menu, press <ESC>. 
 
Total Good Cans Processed: This is the total number of good cans necked and flanged so far 
into the shift. This is essentially a can counter. 
 
Total Transfer Jams: This is the total number of transfer jams for all stations of the machine. 
 
Station #01 jams thru Flanger Jams: This is the total transfer jams for each station. A 
disproportionately high count for a particular station indicates a transfer jam problem for that 
station. 
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________________________________________________________________________________ 
5.6 LAST SHIFT DATA 
 
The “Last Shift” data is identical to the current shift data except it is for the previous 8 or 12 hour 
shift or previous label run, how ever the shift collection is set-up. This allows data collection and 
diagnostics to take place automatically over a two shift period.  
 
 
________________________________________________________________________________ 
5.7 DOWNLOAD PROGRAM TO M4500 
 
This selection is used to download the HSLANCNF application program to the M4500 module. 
This should only be performed when replacing the M4500 or when the program has been changed. 
To download the program, perform the following: 
 
Note: Program download cannot be performed while the necker/flanger is running. All outputs on 
the M4500 are turned “off” and no program execution is performed. Transfer jam detection would 
not take place such that if a jam did occur, the machine would not be stopped. The necker/flanger 
should therefore be stopped while the download takes place. 
 
1) Connect the RS-232 cable from the COM port on the computer to the “PROG” port on the 

M4500. 
 
2) Select “7: Download Program to M4500”. A prompt will be displayed asking to continue or 

abort. To continue, press any key except the <ESC> key. To abort, press the <ESC> key. If a 
prompt stating that the “HSLANCNF.REV” file could not be opened is displayed, then the 
“HSLANCNF” application program is not installed in the current directory. To install the 
program, perform the steps in section 2.3.3 – Application Program Installation, to install the 
program. 

 
3) Once program download is initiated, M4500 program execution will cease, the current address 

being downloaded will be displayed, and the “RUN” LED on the M4500 will flash 
continuously. 

 
4) Once the download is complete, the “RUN” LED on the M4500 will illuminate solid and 

program execution in the M4500 will resume. Press any key to return to the “HSLANCNF” 
main menu. 
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________________________________________________________________________________ 
5.8 DOWNLOAD SET-UP DATA TO M4500 
 
This selection is used to download the previously uploaded (saved) set-up variables to the M4500. 
This should only be performed when replacing the M4500 module.  
 
Note: The set-up data consists of the number of shifts to each station and the number of missing 
cans for transfer jam alarm for each station. Timing channel set-points are not stored as part of the 
set-up data. To download the set-up data, perform the following: 
 
1) Connect the RS-232 cable from the COM port on the computer to the “PROG” port on the 

M4500. 
 
2) Select “8: Download Set-up data to M4500”. A prompt will be displayed asking to continue or 

abort. To continue, press any key except the <ESC> key. To abort, press the <ESC> key. 
 
3) Once data download is initiated, the current address being downloaded will be displayed.  
 

Note: M4500 program execution is not ceased, therefore data download can be performed while 
the machine is running. 

 
4) Once set-up data download is complete, press any key to return to the “HSLANCNF” main 

menu. 
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________________________________________________________________________________ 
5.9 UPLOAD (SAVE) SET-UP DATA FROM M4500 
 
This selection is used to save the set-up variables from the M4500 to the hard drive (current 
directory selected). This should be performed anytime any of the set-up variables have been 
changed.  
 
Note: When the set-up variables are changed, they are changed directly in the M4500, not on the 
file in the computer. By uploading (saving) the set-up variables to disk, they can be downloaded to 
the M4500 in the event the module must be replaced. The set-up data consists of the number of 
shifts to each station and the number of missing cans for transfer jam alarm for each station. Timing 
channel set-points are not stored as part of the set-up data. To upload the set-up data, perform the 
following: 
 
1) Connect the RS-232 cable from the COM port on the computer to the “PROG” port on the 

M4500. 
 
2) Select “9: Upload (Save) Set-up data from M4500”. A prompt will be displayed asking to 

continue or abort. To continue, press any key except the <ESC> key. To abort, press the <ESC> 
key. 

 
3) Once data upload is initiated, the current address being uploaded will be displayed.  
 

Note: M4500 program execution is not ceased, therefore data upload can be performed while 
the machine is running. 

 
4) Once set-up data upload is complete, press any key to return to the “HSLANCNF” main menu. 
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The following is a general description of the timing signals and the locations they should be set at: 
 
CH00: TRANSFER TIMING: This signal should transition from “off” to “on” when cans are 

centered in the middle of the transfer sensors and infeed sensor. This signal should be at 
least 40 degrees wide. 

 
CH01: PLC CLOCK TIMING: This signal is not used by the HSL-ANCNF internally but is 

instead provided for the host PLC as a general timing signal to clock once per can shift. 
CH01 should be programmed “on” for 180 degrees and “off” for 180 degrees but can 
otherwise be programmed to start anywhere as desired. 

 
 
 



SECTION 6 
GENERAL TIMING SIGNAL LOCATIONS 

 
HSL-ANCNF User’s Manual SYSTEMS Electronics Group 

 
- 62 - 

 
 
 

(This Page Intentionally Left Blank) 
 
 
 
 
 



SECTION 7 
RECOMMENDED SPARE PARTS 

 
HSL-ANCNF User’s Manual SYSTEMS Electronics Group 

 
- 63 - 

The following are recommended spares for the HSL-ANCNF. These parts are available through 
Systems Engineering Assoc. Inc. 
 
 
 Quantity Part Number Description 
 
 1ea. M4500 PLC/PLS Processor/Chassis – 4 Slot 
 1ea. P4500 Power Supply 
 1ea. S4563 16 point 10-30VDC Input Board 
 1ea. S4573 16 point 10-30VDC Output Board 
 1ea. D4591 Display/Keypad 
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________________________________________________________________________________ 
MODBUS PORT CONFIGURATION 
 
The MODBUS driver uses the following data format and parameters (the MODBUS port on the 
MODICON PLC must be set to match these): 
 

MODBUS Port (PLC address):  5 
MODBUS Baud:  19.2K 
MODBUS framing mode:  RTU 
Number of start bits:  1 
Number of data bits:  8 
Number of stop bits:  1 
Parity:  NONE 

 
The MODBUS communications driver uses the S4516 communications board to both read and write 
data to a MODICON PLC. 
 
________________________________________________________________________________ 
DATA WRITTEN TO THE MODICON PLC 
 
The following data is written to the MODICON PLC: 
 
 MODICON Dest.  M4500 Source 
 4x Address Data Definition Address 
 401700 Speed (CPM) W182 
 401701 Resolver Position W180 
 401702 Number of Good Cans (Lo-0 to 9,999) W1100 
 401703 Number of Good Cans (Hi-10,000's) W1102 
 401704 Total Xfer Jams (Lo-0 to 9,999) W1104 
 401705 Total Xfer Jams (Hi-10,000's) W1106 
 401706 Xfer Jams Station #1 W1108 
 401707 Xfer Jams Station #2 W1110 
 401708 Xfer Jams Station #3 W1112 
 401709 Xfer Jams Station #4 W1114 
 401710 Xfer Jams Station #5 W1116 
 401711 Xfer Jams Station #6 W1118 
 401712 Xfer Jams Station #7 W1120 
 401713 Xfer Jams Station #8 W1122 
 401714 Xfer Jams Station #9 W1124 
 401715 Xfer Jams Station #10 W1126 
 401716 Xfer Jams Station #11 W1128 
 401717 Xfer Jams Flanger W1130 
 401718 Status (to MODICON) W790 
 401719 Xfer Check Enables (shifts to Stations) W34 
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The bits of the Status register (to the MODICON from the M4500) are mapped as follows: 
 

W790: Status to MODICON (4x address 401718 in MODICON) 
B790.0:  Transfer Jam Station #1 
B790.1:  Transfer Jam Station #2 
B790.2:  Transfer Jam Station #3 
B790.3:  Transfer Jam Station #4 
B790.4:  Transfer Jam Station #5 
B790.5:  Transfer Jam Station #6 
B790.6:  Transfer Jam Station #7 
B790.7:  Transfer Jam Station #8 
B791.0:  Transfer Jam Station #9 
B791.1:  Transfer Jam Station #10 
B791.2:  Transfer Jam Station #11 
B791.3:  Transfer Jam Flanger 
B791.4:  Transfer Jam (any station) Alarm 
B791.5:  PLC Clock Timing 
B791.6:  Timing Signal Fail Alarm 
B791.7:  Not Used 

 
 
The bits of the Xfer Check Enables (shifts to each Station) register (to the MODICON from the 
M4500) are mapped as follows: 
 

W34: Xfer Check Enables to MODICON (4x address 401719 in MODICON) 
B34.0 (F16):  Station #1 Xfer Check (shift to Station #1) 
    thru 
B34.7 (F23):  Station #8 Xfer Check (shift to Station #8) 
B35.0 (F24):  Station #9 Xfer Check (shift to Station #9) 
B35.1 (F25):  Station #10 Xfer Check (shift to Station #10) 
B35.2 (F26):  Station #11 Xfer Check (shift to Station #11) 
B35.3 (F27):  Flanger Xfer Check (shift to Flanger) 
B35.4 (F28):  Infeed Shift In (first bit of shift register) 
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________________________________________________________________________________ 
DATA READ FROM THE MODICON PLC 
 
The following data is read from the MODICON PLC: 
 
 MODICON Dest.   M4500 Source 
 4x Address Data Definition Address 
 401760 Status (from MODICON) W792 
 
 
The bits of the Status/Control register (from the MODICON to M4500) are mapped as follows: 
 

W792: Status from MODICON (4x address 401760 in MODICON) 
B792.0: End of Shift (1=End of Shift) 
B792.1: Not Used 
    thru 
B793.7: Not Used 

 
Note:  Setting Bit0 above to a “1” will reset the Current shift data in the M4500 (passed to 
MODICON addresses 401702 thru 401717).  Prior to setting Bit0 save this data to the previous 
shift buffer in the MODICON if desired.  Bit0 would be set to a “1” for at least 5 seconds at the 
end of shift, then set back to a “0”. 

 
 


